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ABSTRACT 

Introduction: Mpox is a viral zoonosis caused by the Mpox virus. The rise in cases in endemic regions 

since 2005 is strongly correlated with environmental changes such as climate change, deforestation, and 

human migration. 

Isangi Territory has experienced repeated Mpox over the past three years. This situation coincides with 

recurrent floods and significant anthropogenic pressure on the environment, leading to substantial changes 

in land use.  

Methods: This descriptive study aimed to describe the ecological profile of health areas affected by the 

Mpox epidemic in Isangi Territory, using remote sensing data and field surveys. We analyzed land-use 

changes between 2010 and 2024 using Landsat 5 (2010) and Landsat 8 (2024) satellite imagery, mapping 

the forest cover of the Yabaondo, Yakusu, and Yahisuli reserves. 

Results: Health areas reporting suspected cases were characterized by deforested primary forests, oil palm 

plantations, experienced seasonal flooding and Areas with fallow land and secondary forest reported   

Our results reveal a possible link between Mpox and the Isangi landscape.  

Conclusion: Cases predominantly occur in oil palm plantations and deforested areas, suggesting that 

ecosystem modifications favor transmission. Flood-prone areas also play a role, confirming the 

importance of landscape ecology for public health strategies. 
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INTRODUCTION 
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Mpox is a viral zoonosis that has long remained a neglected tropical disease in Sub-Saharan Africa [1]. 

The Mpox virus (MPXV) is an endemic zoonotic virus in West and Central Africa, belonging to the  

Orthopoxvirus genus. In humans, MPXV infection can lead to a smallpox-like illness characterized by 

fever, lymphadenopathy, and a rash. Initially, lesions are macular but eventually transform into papules, 

vesicles, pustules, and finally, scabs [2]. 

 

As of October 5, 2022, over 68,000 laboratory-confirmed cases were reported in 100 non-endemic 

countries [3]. Cases during this epidemic primarily occurred among MSM [4]. The emergence of this 

disease was characterized by rapid international spread with a growing number of cases in new 

geographical areas, a preponderance of the disease among members of a distinct social group, and a 

somewhat atypical clinical presentation, collectively shaped in part by increased international travel, 

human behavior, and viral pathogenicity [5]. 

 

In Africa, Mpox epidemics are common. Between 2017 and 2019, Nigeria reported a record 424 suspected 

MPXV cases and 155 confirmed cases. The highest number of confirmed cases was recorded during the 

2017 epidemic for ages ranging from 21 to 40, whereas historically the disease was more frequent in those 

under 15 [6]. 

 

The DRC alone has reported nearly 85% of known human Mpox cases in recent years, across several 

epidemics [7]. From October 2021 to the end of 2022, 6032 suspected Mpox cases, including 233 deaths, 

were reported in 23 of the country's 26 provinces [8]. 

 

In West and Central African regions where Mpox is endemic, the increase in human cases since 2005 has 

been fueled by climate change, deforestation, war, human migration, and decreased collective immunity 

due to remote smallpox vaccination [9], [10], [11]. Specifically, regarding deforestation, several studies 

have shown that its acceleration means an increase in interactions between wildlife, reservoirs of unknown 

viruses, and human activities, particularly agriculture. Nearly 50% of zoonoses emerging since the 1940s 

are associated with agriculture [12]. 

 

Ecological niche models have been used to better define the geographical extent of areas that are 

ecologically suitable for monkeypox [13], [14], [15], [16]. These models were based on developing an 

understanding of the ecological factors at the location of human cases (using remote sensing data in 

conjunction with human MPX occurrence data), and then identifying the extent of other areas that met the 

same conditions. At the continental scale, models revealed that monkeypox transmission was primarily 

associated with the sub-Saharan African rainforest [15], [17]. At the regional scale, models built from 

historical data and projected into contemporary environmental data in the Congo Basin showed changes 
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in the distribution of suitable conditions with a potential expansion of at-risk areas [13]. In recent years, 

several human cases have been reported in these predicted areas [13]. At the local level, models confirmed 

a higher risk of monkeypox in heavily forested areas [18]. 

 

In the Tshopo province, the Isangi Territory has experienced repeated outbreaks of Mpox epidemics over 

the past three years, primarily in the health zones of Yakusu, Yabaondo, and Yahisuli. Concurrently, this 

territory has faced recurrent floods and significant anthropogenic pressure on the environment, leading to 

important changes in land use. Indeed, Isangi is the most populated territory in Tshopo province and the 

smallest in terms of area. The population of this territory is also confined between large expanses of 

plantations and industrial timber concessions, making it one of the deforestation hotspots in the DRC. 

 

Due to the resurgence of monkeypox outbreaks in the Isangi territory, which appears to present an 

environment conducive to the occurrence of this disease, we deemed it appropriate to conduct the present 

study. Its objective is to describe the ecological profile of the areas affected by the Mpox epidemic using 

remote sensing data and field surveys. 

 

2. MATERIAL AND METHODS 

2.1. Material 

2.1.1. Study Setting 

This multicenter study was conducted in three out of four health zones in the Isangi territory: Yakusu, 

Yahisuli, and Yabaondo, which had reported suspected Mpox cases during our study period. 

 

Located in the center of Tshopo province (24° 15’ 56’’ E and 0° 46’ 48’’ N), Isangi territory is the 

smallest in the province (15,770 km²) but the most populous (estimated population of 701,548 

inhabitants). It is entirely situated within the central Congolese basin at an altitude of 376 m and does 

not border any other province. The prevailing climate is equatorial, and the vegetation is primarily 

evergreen forest [19]. The territory hosts one of the largest forest reserves, the Yangambi Biosphere 

Reserve (225,000 km²), as well as several logging concessions and agro-industrial plantations. 

 

This territory boasts significant hydrography, with numerous waterways crisscrossing almost its 

entire extent. This abundance of waterways, while a source of wealth, also contributes to recurrent 

floods observed in recent years across a large part of the territory. Conflicts related to non-compliance 

with social clauses by industrial timber operators and issues concerning the delimitation of protected 

areas exacerbate tensions with the growing population, who are seeking space for agriculture and 

forest resource exploitation. This makes Isangi territory one of the deforestation hotspots in the DRC. 
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Health Zones in Isangi Territory 

 

 

 

Fig 1: Map of Health Zones in Isangi Territory 

  

2.2. Methods 

2.2.1. Study Type and Period 

This was a descriptive study. Data related to land-use change covered the period from 2010 to 2024. Data 

on notified suspected cases concerned the period from January 2023 to January 2024. Satellite images for 

remote sensing were acquired during February 2024. 

 

2.2.2. Data Collection 

2.2.2.1. Tools 

Satellite Images 

We used Landsat satellite images (freely downloaded from the U.S. government website 

http://earthexplorer.usgs.gov/) to map the dynamics of land use in the three health zones. Two dates (years) 
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were selected: 2010 and 2024, corresponding to the TM (Landsat 5) and OLI-TIRS (Landsat 8) sensors, 

respectively. In addition to these satellite images, other data were used, including: Google Earth images, 

printed and scanned land-use maps of the DRC and the Yabaondo, Yakusu, and Yahisuli territories to 

facilitate photo-interpretation. These vector data helped us precisely delimit our study area. 

  

Table I. Materials and Application. 

 

Tools Applications 

Landsat 8 and Landsat 5 Satellite Images 
Color composite using bands 3,4,5 for Landsat 5 images and 4,5,6 for 

Landsat 8. 

GPS Receiver 
Collection of ground truth points in test areas, geolocation of land cover 

classes. 

QGIS 2.8 and QGIS 3.16 GIS analysis and map layout. 

ENVI 4.4 Image processing (supervised classification). 

Google Earth Photo-interpretation. 

Microsoft Office Word, PowerPoint, Excel 

2013 
Text entry, data processing. 

 

 

2.2.2.2.  Data Collection Techniques 

We conducted a field survey in the three health zones of Isangi territory that reported suspected Mpox 

cases from January 2023 to January 2024. Biological samples were collected from suspected cases during 

a physical examination, where scabs, vesicular fluid, and blood were obtained and sent to the National 

Institute of Biomedical Research (INRB) in Kinshasa. Subsequently, a comprehensive questionnaire was 

used to gather clinical and epidemiological data (not presented in this study), as well as information on 

the presence of palm groves in the community and seasonally flooded health areas. 

 

We employed a methodological approach based on the spatio-temporal analysis of forest cover in the  

Yabaondo, Yakusu, and Yahisuli Reserves, utilizing remote sensing. To achieve this, we acquired data 

via LANDSAT satellite imagery for land cover mapping (forest cover). Landsat 5 (TM sensor, 2010) and 

Landsat 8 (OLI-TIRS sensor, 2024) images were processed for this purpose. 

 

2.2.2.2.1. Image Acquisition and Selection 

Landsat images from 2010 and 2024 (all with a 30 x 30-meter resolution) were used for the spatio-

temporal analysis of land use dynamics. These Landsat images from scenes 176-059 and 176-060 were 

freely obtained from the United States Geological Survey (USGS) website: 

"http://earthexplorer.usgs.gov/". 
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Figure 2. Presentation of the USGS Earth Explorer interface with the Yakusu scene (Path 170 and 

Row 060) 

 

2.2.2.2.2. Visualization and Color Composite 

After downloading and saving the LANDSAT satellite imagery data, a sequence of operations, including 

visualization of the downloaded images, was performed to verify image quality and enhance object 

visibility. 

 

We created a false-color composite using ENVI 4.6.1 software. In this false-color composite, we assigned 

spectral bands 6, 7, and 5 to the RGB (Red, Green, Blue) channels (representing Infrared, Near-Infrared, 

and Red, respectively) for the 1976 MSS sensor image. For the 2022 OLI sensor image, we assigned bands 

6, 5, and 4 (representing Infrared, Near-Infrared, and Red, respectively). 

 

This is considered a false-color composite because the wavelengths we assigned to the three RGB channels 

do not correspond to these three colors. The colors displayed on screen did not match the real colors of 

the observed scene but helped highlight certain land cover classes of high importance for this study, such 

as forests, built-up areas, and water bodies. False-color composites offer the advantage of visualizing data 

not belonging to the visible spectrum, such as infrared, as well as radar, hyperspectral, elevation data, etc. 

In other words, they "transform" non-visible data (but recorded by a sensor) into visible data [20]. 
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2.2.2.2.3 Image Classification 

Satellite image classification is performed using two methods: unsupervised classification methods and 

supervised classification methods [21]. For this study, we used supervised classification methods with 

ENVI 4.4 software. Within this software, the study area on the images was divided into the following 

classes: Primary Forest, Secondary Forest, Fields and Fallows, Bare Soil and Built-up Areas, Plantation, 

Water. 

 

2.2.2.2.3.1. Classification of the 2024 Image 

Based on the examination of the color composite of the area to be classified, we identified different 

spectral signatures corresponding to each legend taxon. Furthermore, a land cover type such as "Primary 

Forest" might exhibit different spectral signatures at the time of image acquisition, depending on, for 

example, the dominant species and canopy density. Therefore, the task was to define as many spectral 

classes as there were spectrally distinct situations for each land cover type. 

 

In the context of this work, the Maximum Likelihood classification algorithm was applied to all pixels in 

the images based on the statistical parameters describing each spectral signature obtained (the means and 

standard deviations between the green, red, and infrared channels). 

 

2.2.2.2.3.2. Classification of the 2010 Images 

While the classification of the 2024 images was based on field measurements, the classification of the 

2010 images was performed retrospectively and deductively, given that we did not have field 

measurements for that period. Thus, the 2024 images served as a reference for processing the older images. 

The samples defined for each class therefore correspond to areas that were assumed not to have changed 

land cover between 2010 and 2024 [J1]. 

 

2.2.3. Definition of Training Areas or ROI: Region of Interest 

This part of the work involved selecting a minimum of 90 to 100 pixels that were spectrally representative 

of each previously identified spectral signature. These samples, or "training areas," were used for the 

"calibration" and "validation" of our classification. This operation was carried out using ENVI 4.4 

software. 

 

2.2.4. Image Preprocessing 

The downloaded satellite images require a certain number of preprocessing operations. This is an 

indispensable step in the satellite image processing workflow that guides the entire methodological 

approach. Image preprocessing, or preliminary analyses, is a set of operations aimed at increasing data 
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readability to facilitate interpretation. When properly executed, these operations contribute to a better 

extraction of useful information [22]. Thus, in this study, the following preprocessing steps were 

performed: 

• Spectral Band Stacking: We combined different spectral bands into a single composite image (a 

multispectral image) to make manipulation easier, allowing processing to occur simultaneously 

across all grouped bands. The ENVI 4.4 remote sensing software was used, and the combination 

was done using the "Layer Stacking" tool. 

• Image Cropping: The downloaded satellite images covered large areas that were not necessary for 

our work. Cropping allowed us to reduce the image size to retain only the area of interest. This 

facilitated and accelerated operations when running algorithms. 

• Mask Creation: To eliminate pixels outside our study area, we created masks. The cropped images 

still contained areas outside the domain of interest. Therefore, a mask was created to display only 

the part of the images corresponding to our study area. The masking layer was the shapefile 

(".shp") of the study area converted to ".evf". This operation was performed in ENVI using the 

"Basic Tools => Masking => Build Mask" tool. 

 

2.2.5. Calculation of Land Cover Class Separability 

The definition of training areas for calibration and validation focused on five predefined land cover 

classes: dense forest, secondary forest, fields and fallows, built-up/bare soil, and water bodies. For each 

image to be classified, a separability measure was performed to avoid confusion between classes and to 

assess the adequacy of the training area selection. This provided insight into the possibility of 

distinguishing these classes and, therefore, producing an accurate classification. Two separability indices 

were calculated in ENVI: "Jeffries-Matusita" and "Transformed Divergence." 

 

2.2.6. Post-processing of Classified Images to Improve Visual Render 

Several post-processing operations can be applied to a classified image to improve its visual render [22]. 

In the context of this study, three post-processing operations were performed to enhance visual quality: 

 

2.2.6.1. Post-classification Filtering 

Post-classification filtering aimed to reduce the salt-and-pepper effect typical of pixel-based 

classifications, with the goal of reorganizing misclassified pixels. To do this, we proceeded as follows: 

performed a majority analysis via the menu "Classification > Post Classification > Majority/Minority 

Analysis." 
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2.2.6.2. Improving Class Colors 

This operation involved applying intuitive colors to each land cover class. To do this, we proceeded as 

follows: selected the menu "Tools > Color Mapping > Class Color Mapping." 

 

2.2.6.3. Conversion of Post-Classification Filtering Output to Multiple Formats 

The output of the post-classification filtering was converted in two steps: first, from the classification to 

an ENVI vector format ("Classification > Post classification > Classification to vector"); then, from the 

ENVI vector to a Shapefile ("Availablevectorlayers > File > Export layers to shapefile") to populate the 

QGIS 3.16 attribute table for cartographic layout. 

 

2.3. Annual Deforestation Rate in the Study Area 

The deforestation rate (Td) is expressed as the percentage of forest area lost per year (%/year). The variable 

considered is area (S). Several formulas currently exist to estimate the deforestation rate. In this study, we 

used the Catalan formula (1991). The rate was calculated as follows: 

 

 

 

 

 

 

Where: 

• A1 = Forest area in the initial year (ha) 

• A2 = Forest area in the final year of the analyzed period (ha) 

• n = Time between A1 and A2 

 

2.4. Change Detection Analysis with Transition Matrix 

The analysis of land-use change involves presenting the 2010 and 2024 maps within the scope of this 

study. A crossing of the two land-use maps yielded a change map and a matrix that reflected the evolution 

of different classes between these two dates. 

 

We recorded Geographic Information System (GIS) data on the latitude and longitude of health areas that 

reported suspected cases and proceeded with the distribution of suspected cases, where each point 

corresponded to one percent of suspected cases in the health zone. 
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3. RESULTAT 

3.2.1. Yabaondo Health Zone 

 

Table II. Land Use Dynamics and Suspected Case Notification in Yabaondo 

 

. LAND USE DYNAMICS NOTIFICATION 

Class 

Area (ha) Balance (ha) Deforestation 

rate (%) 

Health area Suspected 

case 

% 

Yabetuta 33 12.4 

Logoge 22 8.2 

 2010 2024   Imbolo 44 16.5 

Water 4533.48 6587.1 +2053.62   Botumanya 50 18.7 

PF 380653.92 263499.21 -117154.71 2.198 Itenge haut 41 15. 4 

SF 32794.2 54788.58 +21994.38   Yaboila 41 15.4 

FL 38030.04 77836.23 +39806.19   Mumba losuna 20 7.4 

BS 21612.96 73268.82 +51655.86  Yanguba 16 6 

Total  477624.6 475979.94 -1644.66   Total 267 100 

*PF= primary forest, SF= secondary forest, FL= fallow land, BS= bare soil 

 

The annual deforestation rate (loss of primary forests) was 2.19% in the Yabaondo health zone, 

representing a loss of 117,154.71 ha between the two study periods. This decrease in primary forest area 

was reflected by dramatic increases in the surface areas of other land use types. The health areas of 

Botumanya, Imbolo, Itenge-haut, and Yaboila collectively reported the majority of suspected Mpox cases. 

 

In the Yabaondo health zone, four Mpox hotspots were observed: Health areas with palm groves (red dot): 

66% of suspected cases, Health areas with deforested primary forest (purple dot): 20.6% of suspected 

cases, health areas with fallow land, secondary forest (blue dot): 13.4% of suspected cases and Flood-

prone health area (black dot): 12.4% of suspected cases. 
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Figure 3. Land Use Change and Distribution of Suspected Mpox Cases in Yabaondo Health Zone: 

A Vegetation Profile in 2010, B Vegetation Profile in 2024, and C Distribution of Mpox Cases 

Superimposed on Vegetation Profile in 2024. 

 

3.2.2. Yahisuli Health Zone 

 

Table III. Land Use Dynamics and Suspected Case Notification in Yahisuli 

 

LAND USE DYNAMICS NOTIFICATION 

Class 

Area (ha) Balance (ha) Deforestation 

rate (%) 

Health area Suspected 

case 

% 

Mokombe 30 21.1 

 2010 2024   Yaeme 48 33.8 

Water 2048.4 3219.93 +1171.53   Likoli 5 3.5 

PF 227698.56 164829.33 -62869.23 1.972 Yauta 29 20.4 

SF 38105.28 62674.29 +24569.01   Yaolenga 10 7 

FL 18366.48 65753.64 +47387.16   Yahisuli 15 10.6 

BS 40584.6 29198.25 -11386.35  Yaokoli 5 3.5 

Total  326803.32 325675.44 -1 127.88   Total 142 100 

*PF= primary forest, SF= secondary forest, FL= fallow land, BS= bare soil 

 

 



             International Journal of Applied Science and Engineering Review 

 

ISSN: 2582-6271 
 

Vol. 6, Issue.3, May-June 2025, page no. 143-161 

 

https://ijaser.org Page 154 

 

The annual deforestation rate (loss of primary forests) was 1.97% in the Yahisuli health zone, representing 

a loss of 62,869.23 ha between these two study periods. This decrease in primary forest area was reflected 

by increases in the surface areas of other land use types, with the exception of bare soil. The health areas 

of Mokombe, Yaeme, and Yauta collectively reported the majority of suspected Mpox cases in the zone. 

 

Health areas with deforested primary forest (Yaeme, Yahisuli, and Yauta) reported the majority (64.8%) 

of suspected Mpox cases in this zone, followed by the health area with palm groves (Mokombe: 21.1%) 

and flood-prone health areas (Yahisuli and Yaolenga: 17.6%). The remaining cases occurred in health 

areas with fallow land and secondary forest (Lokoli, Yaokoli, and Yaolenga: 14%). 

 

 

 

Fig 4. Land Use Change and Distribution of Suspected Mpox Cases in Yahisuli Health Zone: A 

Vegetation Profile in 2010, B Vegetation Profile in 2024, and C Distribution of Mpox Cases 

Superimposed on Vegetation Profile in 2024. 

 

3.2.2. Yakusu Health Zone 
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Table III. Land Use Dynamics and Suspected Case Notification in Yakusu 

 

LAND USE DYNAMICS NOTIFICATION 

Class 

Area (ha) Balance (ha) Deforestation 

rate (%) 

Health area Suspected 

case 

% 

Yelenge  36   12.7 

 Yaoseko  58   20.4 

 Yalongosa  22 7.7 

 Yaselia  42 14.8 

 2010 2024   Bolongo  38   13.4 

Water 11143.08 11111.4 -31.68    Yalanga  10   3.5 

PF 247392.36 245306.16 -2 086.2 0.16865517 Yaotike   32   11.3 

SF 53091 60045.84 +6 954.84    Yasendo  26   9.2 

FL 46503.36 42560.28 -3 943.08   Ilota    10  3.5 

BS 3552.12 2654.28 -897.84   Ikongo   10 3.5 

Total  361681.92 361677.96 
- 3.96   

Total 
284 100 

*PF= primary forest, SF= secondary forest, FL= fallow land, BS= bare soil 

 

The Yakusu health zone experienced an annual deforestation rate of 0.16%, equivalent to a loss of 2,086.2 

ha between the two study periods. The health areas of Yaoseko, Yalongosa, Bolongo, and Yelenge 

collectively reported the majority of suspected cases in the zone. 

 

Health areas with deforested primary forests reported the majority of suspected cases in the zone (Yelenge, 

Yaoseko, Yalongosa, Yaselia, Yasendo: 64.8%), followed by flood-prone health areas (Yelenge, Yaoseko, 

Yalongosa, Bolongo: 54.2%), and health areas with palm groves (Bolongo, Yaotike, Yalanga: 28.2%). 

Other health areas (fallow land, secondary forest) reported 7% of the suspected cases in the zone. 
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Fig 5. Land Use Change and Distribution of Suspected Mpox Cases in Yakusu Health Zone: A 

Vegetation Profile in 2010, B Vegetation Profile in 2024, and C Distribution of Mpox Cases 

Superimposed on Vegetation Profile in 2024. 

 

 

4. DISCUSSION 

The majority of suspected Mpox cases originated from health areas with deforested primary forests (64.8% 

in Yakusu, 64.8% in Yahisuli, and 20.6% in Yabaondo). In the DRC, Mandja B et al. found that primary 

forest (IRR 1.034, 95% CI 1.029–1.040) was positively associated with the annual incidence of Mpox [7]. 

Furthermore, Thomassen HA et al. observed that deforestation was a significant determinant of Mpox 

transmission in Sankuru and that land-use changes could influence the distribution and abundance of 

reservoir species. The majority of areas where an increase in Mpox was predicted were covered by forests, 

where presumed reservoir species were naturally present. Land conversion in these areas was rampant, 

with primary forest being transformed into secondary forest due to timber extraction or into agricultural 

fields [14]. The works of Singh A and Shaikh B [23], as well as K. Brown and P. Leggat [24], noted that 

deforestation could also have played a role in the resurgence of the disease or its ability to spread. Studies 

by J. Thornhill et al. [25] and E. Whitehouse et al. [26] confirm that human activities such as deforestation, 

agricultural expansion, and urbanization have increased contact between humans and wildlife, which 

raises the risk of transmitting diseases like monkeypox. The increased proximity between human 

populations and virus-carrying animals, particularly rodents and primates, favors the spread of the disease. 

This phenomenon is particularly visible in Central Africa, where the destruction of natural habitats has 

intensified these interactions. To address this situation, appropriate measures such as educating and raising 
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awareness among populations living near deforested areas about the increased risks of contact with wild 

animals that are potential Mpox virus carriers are therefore essential. Messages should focus on risky 

practices (hunting, handling dead animals) and preventive measures (hygiene, proper cooking of 

bushmeat). Furthermore, promoting sustainable economic alternatives that can support alternative 

economic initiatives to deforestation for local communities, such as sustainable agroforestry, ecotourism, 

or the production of non-timber forest products, is indispensable. This could reduce pressure on primary 

forests and thus reduce contact between humans and wildlife. 

 

In this study, health areas with palm groves or oil palm plantations also reported suspected cases of the 

disease (66% in Yabaondo, an area hosting an agro-industrial oil palm plantation; 28.2% in Yakusu; and 

21.1% in Yahisuli, two health zones with oil palm plantations belonging to family farmers). In the DRC, 

Fuller T et al., in their study on using remote sensing to map the risk of Mpox virus spread in the Congo 

Basin [18], suggested that the best predictors of human Mpox cases were proximity to dense forests and 

the associated habitat preferred by rope squirrels (oil palm plantations). The risk of contracting Mpox was 

significantly higher near sites considered habitable for squirrels (oil palm plantations) (OR = 1.32; 95% 

CI 1.08-1.63). Thus, they recommended that semi-deciduous tropical forests with oil palm, the primary 

food source for rope squirrels, be prioritized for Mpox surveillance. Indeed, squirrels of the genus 

Funisciurus are known to be hosts for the Mpox virus, and oil palm plantations provide them with an 

abundant food source and a favorable environment for their proliferation. Furthermore, as game, they 

constitute an important protein source in rural areas, which increases their contact with humans who hunt 

and consume them. 

 

Health areas prone to flooding reported some suspected Mpox cases in our study (Yakusu: 54.2%, 

Yahisuli: 17.6%, Yabaondo: 12.4%). In Nigeria, Alakunle E et al. noted that floods bringing humans and 

MPXV-infected animal hosts into closer proximity were a significant factor in Mpox emergence [6]. A 

multi-year study of small terrestrial animals sampled in a highly Mpox-endemic region of the DRC, 

conducted by Doty JB et al., revealed a relative scarcity of orthopoxvirus-seropositive animals in edaphic 

forest areas (seasonally flooded) [27]. This suggests the displacement of these animals to drier areas, 

thereby facilitating contact with humans seeking dry locations during or after floods. 

 

5. LIMITATIONS OF THE STUDY 

This study has a few key limitations to consider: 

• No Causal Link Established: As a descriptive study, it can't determine if environmental factors 

directly cause Mpox cases in the Isangi territory. To understand causality, correlation studies 

would be needed. 
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• Limited Environmental Factors Explored: The study primarily focused on physical and 

biogeographical environmental factors like dense forests, deforestation, palm oil plantations, and 

flood-prone areas. This means other potentially important environmental factors, such as climatic 

variables (temperature, precipitation), were not investigated. 

• Subjectivity in Flood-Prone Area Assessment: The characterization of flood-prone health zones 

relied on field surveys.   

• This method can introduce subjective bias. Using techniques like remote sensing or   

• other spatial mapping methods could have provided more objective and precise data, but this wasn't 

feasible due to budget constraints. 

• Spatial Analysis Precision: The study used the geolocation of health zones as its unit for spatial 

analysis, rather than the individual geolocation of Mpox cases. This approach limits the precision 

of the spatial analysis and might hide significant local variations in case distribution and their link 

to environmental factors. A more granular geolocation of individual cases would have allowed for 

a more detailed spatial analysis and a better understanding of local risk factors. 

 

6. CONCLUSION 

This descriptive study, conducted in three health zones within the Isangi territory, allowed for the 

development of an ecological profile of health areas that reported suspected Mpox cases. Our observations 

reveal that the health areas where suspected cases were reported exhibit certain notable ecological 

characteristics, specifically the presence of deforested primary forests, palm groves/oil palm plantations, 

and to a lesser extent, flood-prone areas. These findings describe the environmental context in which the 

occurrence of suspected Mpox cases was observed in the studied zones. Correlation studies are therefore 

essential to elucidate potential associations between these environmental variables and the occurrence of 

Mpox in this territory. 
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